
 What Changes Were Made in ACT! by Sage 2009 (11.1)

 Question
 You would like to know what changes have been made in ACT! by Sage 2009 (11.1). 

 Answer
ACT! 2009 (11.1) and ACT! by Sage Premium 2009 (11.1) are new releases in the ACT! product line and are referred to 
collectively as ACT! 2009 (11.1) in this document. The ACT! 2009 (11.1) release is focused on improving usability of top task areas 
and allowing users to be more productive. This list is provided to improve your installation and overall use experience of ACT! 
2009 (11.1).  
 

1. New Features in the Release  
2. Fixed Issues  
3. Known Issues - New in the Release  
4. Known Issues - Existed in Previous Release  
5. Compatibility  

 
 
New Features in the Release  
New and Improved features in the 2009 Product Family are focused in the areas of Improving Usability and User Productivity in 
Top Task Areas as well as further Automating and Simplifying Installation.  
 
Contacts/Groups/Companies  
Relationships Tab - Allow users to "link" or create relationships between contacts  
Related Contacts allows users to document existing influential relationships between contact in their database. For example, if 
Client A has an influential relationship with Client B, then I can store that information in the database to use in future sales of 
marketing campaigns, or be able to browse the information when I am looking up a particular contact.  
 
For more about the new Relationships tab, see the following Knowledgebase article:  

How To Use the New "Relationships" Tab in ACT! by Sage 2009 (11.1) 
Answer ID: 23893 

 
Enhanced Usability - New "Import Date" field  
To complement the "Is Imported" field on the contact, group or company records, a new "Import Date" field had been added to 
provide users visibility into last import event date for reporting purposes. The field is available for lookups, reports and can easily 
be added to the layout using Tools > Design Layouts.  
 
Enhanced Usability - Last Import Location  
During database import, the last location where users searched for their imported file is set at the default location to make it easier 
to locate the source database.   
 
Enhanced Usability - F6 toggles to previous layout Pressing F6 on the keyboard will toggle between the current and the previously 
used layout.  
 
Dashboard  
Enhanced Usability - Drilldown for specific bar and pie slice rather than the entire component  
This option allows users to drilldown the bar and pie slice by displaying the activities or opportunities associated with that slice. A 
new menu item has been added to the component's right-click menu - "View All Data in List" to show all activities or opportunities 
in a list view similar to the original drilldown behavior.   
 
Activities/Opportunities  
Enhanced Usability - Activity Association with Companies  
You now have the option to remove the existing company association from an activity if you decide to reschedule it with a different 
contact. This feature enables you to keep your associated company information consistent with the contact's company name.  
 
Filter Activity/Opportunity by Yesterday  
This feature enables you to filter your task list and opportunity list by selecting Yesterday as your filter. On this task list it will show 
all activities that have a start date of yesterday and opportunity list will show all opportunities that have yesterday as their expected 
close date.  
 
Enhanced Usability - Pop-ups on calendar items  
Calendar item tool will shoe multiple contacts if more than one contact is associated with the activity.  
 
Enhanced Usability - Company names in Alarm dialog  
Alarm pop-ups will display the company information for each activity contact in the list giving you a consistent calendar-like view of 
all activities. This feature used to exist in ACT! 2000 (5.0) and has been reinstated in the current release.  
 
Enhanced Usability - Go To multiple selected alarms  
As part of the standard ACT! workflow for performing a lookup and working within the list, the Go To button on the alarms dialog 
will take you to the list of contacts associated with all selected activities. The alarms dialog will remain open while your list view 
changes in the background.  
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Attachments  
Enhanced Usability - Mouse-over on Attachments and Documents shows physical filename  
In order to improve discoverability of attachments, the tooltip for selected attachments will now show the complete physical path to 
the actual file.  
 
Histories  
Enhanced Usability - Edit "Regarding" list when recording new history  
Users can now edit the "Regarding" dropdown from within the new history dialog the same way as when scheduling a new activity. 
 
 
Enhanced Usability - History icon on Toolbar  
To give further accessibility into history creation, a new History icon has been added to the standard toolbar so users can quickly 
create histories regardless of what view or layout they are currently using. The history dialog pops up with the history automatically 
associated to the last contact that was viewed on the contact detail view. Users have the option to change history association any 
time prior to clicking OK.  
 
Installation  
Enhanced Usability - Improved installation experience  
Significant changes have been made to enhance the overall installation experience. Users are given two options to perform 
installation - "Typical" and "Custom". It takes fewer clicks to complete a typical install providing a consistent and friendly feedback 
to users during the install process. Custom installation provides much more accessibility into install options for customized 
settings.  
 
Licensing/Activation  
Activation behind proxy  
If a proxy server is detected during the registration process, a dialog is displayed to enter user name and password in order to 
connect and activate through the proxy server.  
 
Mail Merge  
Enhanced Usability - Sticky options settings  
All mail merge wizard options are "sticky" when the user clicks the finish button. This reduces the time required to do subsequent 
mail merges if the options are same as the first time.  
 
Preferences  
Default Backup location preference  
A new preference is available for users to specify the default backup location in the preferences dialog.  
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Fixed Issues  
 
Microsoft® Outlook® Integration  

 ACT! to Outlook calendar copy did not update the free/busy calendar in Outlook at the end of calendar-copy for recurring activity day 
instances until the appointment is opened and re-saved inside Outlook.  

 Previously, Outlook e-mail attach to contacts feature (including Outlook rules) matched contacts using the contact name instead of the e-
mail address. This has been addressed to follow a consistent contact matching standard for both "Quick Attach" and "Attach to ACT! 
Contacts options. For "Quick Attach", if multiple contacts consist of the same e-mail address on any e-mail type field, the e-mail will be 
attached to all matching contacts. If no matching contacts exist with the same e-mail address a new contact will be created. For "Attach to 
ACT! Contacts", the contact picker dialog will be pre-populated and pre-selected with all matching contacts in the database.  

 Items in the "Not Attached Messages" tab in the Quick Attach Progress UI were incorrectly displayed by duplicating the information in the 
"To:" or From:" fields.  

 Images embedded inside and ACT! e-mail template appeared as attachments when sent via Outlook with Word as the e-mail editor.  
 Last e-mail field did not update when e-mail history was set to "Attach to Contact"  
 History was not recorded if a user performed a mail merge immediately after installing ACT! by Sage 2008 until ACT! was restarted at 

least once.  
 E-mail Attach to Contact behaved differently when e-mail was attached to contact from within Outlook Inbox vs. opened e-mail window. In 

the latter case, only history was created with subject but the e-mail was not attached.  
 Outlook Add-in failed to load when SQL service was disabled because it was trying to access the database engine and timing out.  

Mail Merge 
 When creating a new Mail Merge template or editing and existing Mail Merge template, the Mail Merge UI was not present for the 

following configuration: Windows Vista® 64-bit with Microsoft Word 2003.  

Printing 
 Calendar Quick-print did not include the calendar title bar to clarify the day, week, or month that the calendar belonged to, for example 

"October 2008" or "Monday, October 13, 2008."  

Synchronization/Remote Databases 
 Only a few controls inside the Sync Panel accepted keyboard typing as input.  
 Users used to get message "ACT! Network Sync Service is unavailable. Please install the service to run sync server" when the 

Domain/Workgroup for the machine hosting the Network Sync Services was changed.  
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 In some cases, Address and Phone fields did not synchronize between main and remote databases.  

Contact/Groups/Companies 
 No message existed to warn users that private contacts belonging to a user will be lost when that user is deleted. The message has been 

added in this release.  
 Updated Company-Contact Linked Fields did not function when spillover table fields are linked to a company.  
 Tabbing into Data field on Contact layout changed the date value back one day if edited in a later time zone.  

Activities/Histories/Notes 
 Activity and History Records could not be deleted if they had a read-only file attached.  
 Incorrect activity count was displayed on the calendar's statues bar due to timeless and recurring activities.  
 Group and Company activities tab did not apply the correct user filter based on the selected user.  
 Last attempt field did not update when manually creating a call history with "Call Left Message" status.  
 History type filter did not display all histories with e-mail history types in the history grid view.  
 When scheduling a new activity from Task List, the "Schedule With" was set to the Contact associated with the arbitrarily selected task as 

opposed to contact in the detail view.  

Dashboards 
 The Opportunity by User component incorrectly showed the custom sales cycle stages in the legend when the ACT! Sales Cycle was 

selected as the filter.  
 When designing a new dashboard, an error message "Value cannot be null" was displayed if custom date range was chosen for default 

dashboard filters.  

Opportunities 
 RTF formatting in opportunity details did not save correctly when opportunity was closed and reopened.  

Preferences 
 Default history creation preference was not retained when using ACT! E-mail as client.  
 Newly created custom activity types did not show up in the scheduling preferences dialog.  

Excel® Integration 
 Map to Excel on the documents tab did not work with group and company fields and displayed an ambiguous error message.  

Import 
 Spillover fields were not listed in the destination fields dropdown on the Import Wizard mapping page.  

Other 
 In some cases, customizing columns in list views and tabs did not retain settings.  
 Schema update from ACT! by Sage 2007 (9.0) to ACT! 2009 (11.0) caused exceptions.  
 In some cases, check and repair within ACT! caused database error. Now, users will get an option to perform a more extensive repair 

with potential data loss, or call tech support for further assistance.  
 Custom defined multi-select dropdown lists sometimes added additional values if several items were selected by default, causing the list 

to show more than what was available.  

Return to Top

Known Issues - New in this release  
This list encompasses the most frequently encountered items in ACT! 2009 (11.1) that were found in the current release. The 
known issues include a description along with any identified workarounds or recommendations.  
 
Contacts/Groups/Companies 

 Linked Spillover fields do not refresh and show the updated data until users refreshes the view or restarts ACT!. 

 Workaround: clicking View -> Refresh should refresh the field information. 

 Current Company lookup is not retained after any Define Field change is performed for the company fields.   

 Workaround: Perform the company lookup after doing the Define Field change.  

 Note: In upgrade scenario, "Relate Contact" menu items is missing from the Contacts menu. 

 Workaround: contact relationships can be formed by using the toolbar button on "Relationships" tab. 

Outlook Integration 
 Creating a new Contact in from e-mail message populates the new contact dialog with Outlook user information as opposed to the "From" 

contact. 

 Workaround: Manually edit the contact dialog to match sender's information. 

Dashboards 
 The legends boxes in Opportunity by Stage dashboard components do not show all stages fro opportunities if "All Stages" is used as the 

filter criteria. 

 Workaround: Add up to 3 individual stages that you would like to see.  

Mail Merge 
 An image added to a fixed location on a mail merge template does not appear on all pages when the mail merge is performed.  

 NOTE: This occurs when the image is part of the header.  
 Workaround: Remove and re-add the image to the header so it gets included on all pages.  

Return to Top
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Known Issues - Existed in previous release  
This list encompasses most frequently encountered issues in ACT! 2009 (11.1) that were present in a previous release. The 
known issues include a description along with any identified workarounds or recommendations.  
 
Activities/Notes/Histories 

 Timeless activity dates changes to previous day if users are in a different time zones. 

 There are no issues with timeless activities when all users are in the same time zone.  
 Example for when an issue occurs: 

 A user in the EDT time zone schedules a timeless activity for 5/30  
 A user in the PDT time zone (-3 hours from EDT) will see this activity scheduled for 5/29 due to the time difference of -3 

hours between EDT and PDT which shifts the activity from 5/30 12:00 AM to 5/29 9:00 PM.  

 Consecutive addition of histories causes memory usage to rise when hundreds of histories are added. 

 Workaround: Restart ACT! of PC after adding hundreds of history records.  

 Logged in user's activity records are displayed when filtered specifically by that user, but not when filter is set to "All Users". 

 Workaround: Set the filter criteria to single user so only that user's activities are shown on the calendar. 

Install/Uninstall/Setup/Startup 
 When uninstalling ACT! 2008, users need to uninstall Microsoft SQL Server® 2005 Express Edition from add/remove programs in order to 

reinstall ACT! by Sage 2006 (8.x) or ACT! 2005 (7.x).  
 On Windows Vista operating systems, you must Run As Administrator when performing an ACT! Update, sharing a database, using the 

Scheduler or Registering the product. 

 Workaround: To run as Administrator, right mouse click on the ACT! shortcut and select "Run as Administrator."  

Conversion/Import/Export 
 User can map fields into fields that are read-only, but data is not imported.  
 When importing contacts with 'Replace with Source Contact' option, the first and last name are no longer parsed.  

Outlook Integration 
 Microsoft changed the design of meeting invitations with Service Pack 2 for Outlook 2003. When a user accepts or tentatively accepts a 

meeting, either from a meeting request or from a calendar item, the existing calendar item is deleted from the calendar. Additionally, a 
duplicate of the calendar item. Duplicate activities are created in ACT! when a user accepts or tentatively accepts a meeting in Outlook. 

 Workaround: By default, this new meeting acceptance behavior is enabled in Outlook 2003 SP2. However, the behavior can be 
disabled or re-enabled by using a registry key. Detailed information about how to disable or re-enable the registry key can be 
found at http://support.microsoft.com/?id-899919.  

 Bi-weekly reoccurring Sunday events copy incorrectly to Outlook calendar. 

 For example: 

 Create a recurring activity on October 5th to occur every two weeks and copy calendar to Outlook  
 Activity shows up on Outlook Calendar to October 12th and 26th. 

 ACT! History options are not available on the e-mail dialog when performing File ->Send to ->Mail Recipient inside a Word Document.  
 Business Address 1 field does not map correct Outlook address field when a contact is e-mailed as an ACT! VCard and then opened 

inside Outlook on the receiving end.  

Contacts/Groups/Companies 
 Note: Updating linked contacts for a company is designed to update all linked contact fields with the content of the company record on 

any change of the company record. That means that the content of ALL linked contact fields is replaced with the content of the linked 
company fields, including blank fields, whenever any of the linked company fields changes.  

 Required contact fields can be left blank if contact is created from a Company record.  
 In some cases for Group and Company detail view, when you select the contact or opportunity tab the Tools ->Customize Columns menu 

item is disabled. 

 Workaround: Display the "Customize Columns" dialog via the Options control on the tab's tool bar.  

 The context menu for the Record Manager field does not contain the option to perform lookup using record manager as criteria. 

 Workaround: Use Lookup -> Other Fields, then select the Record Manager field in the Look Contacts dialog.  

 Search Option in Group and Company List views does not have a consistent look-ahead functionality as the Contact List View. When 
typing characters in the textbox, it replaces previously entered characters with new keystrokes instead of perform lookup using existing 
characters.  

Lookups 
 Lookup on the secondary contact field retrieves incorrect number of records.  

Synchronization/Remote Databases 
 On Windows Vista operating systems, you must Run As Administrator when creating a remote database. 

 Workaround: To Run As Administrator, right-click on the ACT! shortcut and select "Run As Administrator." 

 ACT! user must have Windows® Administrator rights to successfully create a remote database. A Standard Windows user cannot create 
a remote database. A Windows Standard use will get an "Access to path {...} denied" message. 

 Workaround: Grant Windows Administrator rights to ACT! users who need to be able to create remote databases.  
 Notes that were deleted on one remote database do not sync to the second remote in a multiple remote database synchronization 

scenario.  

Mail Merge 

Page 4 of 5Customer Support - Sage Knowledgebase -- Sage Products For Small Businesses

2/12/2009http://kb.sagesoftwareonline.com/cgi-bin/sagesoftwareonline.cfg/php/enduser/prnt_adp.ph...



 

 Memo fields added to ".tpl" Templates lose formatting when merged to e-mail. (80034)  

Reports 
 An error is displayed ~ "Index was outside the bounds of the array", if the Vertical Spacing option is selected to align fields when creating 

new report from template.  
 When adding a Contact Activity type field to a new Report Template, the Contact field is not present in the dialog showing list of available 

fields.  
 Picture fields do not display when used in reports.  

Installation 
 Over install of ACT! 2009 (11.0) opens with a minimized window pinned to the upper left corner of the screen. New installations and path 

installs do not have the same problem.  

ACT! Log Viewer 
 ACT! Log Viewer cannot display in html. If you click the 'convert to HTML' button an error will occur.  

Other 
 Some filter drop-down lists can become truncated and the last item in the checkbox list may not be accessible (a scroll bar may not be 

present). This issue exists on the following filter drop-downs: Contact Activities tab ('type' & 'priority' filters); Group Activities tab ('type' 
filter); Task List view ('type' & 'priority' filters); Calendar view ('type' filter); Opportunity List view ('stage' filter). 

 Workaround: Click on the check box for the last item in the drop-down list or select 'None' at the bottom of the drop-down, and 
the scroll bar will (re)appear. 

 User are unable to attach a Web page to an ACT! contact in a Citrix® environment using the "Attach Web Page to Contact" feature. 

 Workaround: Save page locally and then attach it as a file. 

 The total number of the opportunities shown on the Opportunity by Company report counts opportunities multiple times when they are 
with more than one contact. However, the totals are correct.  

 In come case if upgraded from ACT! 6.0 to ACT! 2008, sending e-mail from ACT! crashed Lotus Notes®.  
 Setting DPI to 120 truncates buttons and text in the conduit configuration wizard for Palm Link and Pocket PC Link.  
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Compatibility  
 
ACT! for Palm OS 

 ACT! for Palm OS® 3.0 is not compatible with ACT! 2009 (11.1). ACT! 2009 (11.1) will not install on a machine that has ACT! for Palm 
OS 3.0 installed.  

Sage Software makes no warranties, representations or undertakings about any of the content of articles (including, without limitation, any
as to the quality, accuracy, completeness or fitness for any particular purpose of such content). 
 
The contents of articles are Copyright © Sage Software 2006. Reproduction of part or all of the contents in any form is prohibited unless for
personal use. None of the content of this article may be copied or otherwise incorporated into any other document, publication or other work
in any form (whether hard copy, electronic or other). 

© 2006 Sage Software SB, Inc. All Rights Reserved. 
 

Please visit the Knowledge Center / Live Chat Assistance again soon!  
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